
 
 

 

 

 

 

 

 

D3CM1604V  
 Administrator Manual 

 

EMTA Cable Modem 
 

 

 

 

 

 

 

 

 

FastFind Links 
 

Getting to Know the EMTA 

Installing the EMTA 

Preconfiguration Guidelines 

Configuring the EMTA 

 

 

 



 

 

 
SMC Networks 

20 Mason  
Irvine, CA. 92618 

U.S.A. 
 

Copyright © 2013 SMC Networks 
All Rights Reserved 

 
Information furnished by SMC Networks, Inc. (SMC) is believed to be accurate and reliable. However, 
no responsibility is assumed by SMC for its use, or for any infringements of patents or other rights of 
third parties which may result from its use. No license is granted by implication or otherwise under 
any patent or patent rights of SMC. SMC reserves the right to change specifications at any time 
without notice 
No part of this publication may be reproduced or transmitted in any form or by any means, electronic 
or mechanical, including photocopying and recording, or stored in a database or retrieval system for 
any purpose without the express written permission of SMC.  
Microsoft and Windows are registered trademarks of Microsoft Corporation. Apple and Macintosh are 
registered trademarks of Apple, Inc. All other brands, product names, trademarks, or service marks 
are property of their respective owners.  
This product (Models: D3CM1604V) includes software code developed by third parties, including 
software code subject to the GNU General Public License (“GPL”) or GNU Lesser General Public 
License (LGPL”). As applicable, the terms of the GPL and LGPL, and information on obtaining access 
to the GPL code and LGPL used in this product, are available to you at http://gpl.smc.com/. The GPL 
code and LGPL code used in this product is distributed WITHOUT ANY WARRANTY and is subject to 
the copyrights of one or more authors. For details, see the GPL Code and LGPL Code for this product 
and the terms of the GPL and LGPL.  
 
 



 

iii 
D3CM1604V EMTA Cable Modem Administrator Manual 

Contents 

Preface ...................................................................................................................... v 

Key Features .............................................................................................................. vi 
Document Organization .............................................................................................. vii 
Document Conventions .............................................................................................. vii 

Safety and Warnings ............................................................................................ vii 
Typographic Conventions .......................................................................................... viii 

1 Getting to Know the EMTA................................................................................... 9 

Unpacking Package Contents ................................................................................... 10 
System Requirements ............................................................................................... 10 
Front Panel ................................................................................................................ 11 
Rear Panel ................................................................................................................ 13 
Using the Reset Button ............................................................................................. 15 

2 Installing the EMTA ............................................................................................ 16 

Finding a Suitable Location ....................................................................................... 17 
Connecting to the LAN .............................................................................................. 18 
Connecting the WAN ................................................................................................. 19 
Connecting to the Public Telephone Network ........................................................... 19 
Powering on the EMTA ............................................................................................. 20 

3 Preconfiguration Guidelines .............................................................................. 21 

Configuring Your Computer for TCP/IP ..................................................................... 22 
Configuring Microsoft Windows 2000 .................................................................. 22 
Configuring Microsoft Windows XP ..................................................................... 23 
Configuring Microsoft Windows Vista .................................................................. 24 
Configuring Microsoft Windows 7 ........................................................................ 27 
Configuring an Apple® Macintosh® Computer ..................................................... 30 

Disabling Proxy Settings ........................................................................................... 31 
Disabling Proxy Settings in Internet Explorer ...................................................... 31 
Disabling Proxy Settings in Firefox ...................................................................... 31 
Disabling Proxy Settings in Safari ....................................................................... 32 

Disabling Firewall and Security Software .................................................................. 32 
Confirming the EMTA’s Online Status ....................................................................... 32 
Confirming Your Computer’s Link Status .................................................................. 32 



Contents 

iv 
D3CM1604V EMTA Cable Modem Administrator Manual 

4 Configuring the EMTA ........................................................................................ 33 

Accessing the EMTA’s Web Management ................................................................ 34 
Understanding the Web Management Interface ........................................................ 35 
Web Management Interface Menus .......................................................................... 36 

Viewing System Software Settings ................................................................ 37 
Viewing Network Connectivity ....................................................................... 38 
Configuring Security Settings ........................................................................ 40 
Viewing the MTA Initialization Status ............................................................ 41 
Viewing DHCP Information ............................................................................ 42 
Viewing Quality of Service Information .......................................................... 43 
Viewing Provisioning Information .................................................................. 44 
Viewing the Event Log ................................................................................... 45 

5 Troubleshooting Procedures ............................................................................. 46 

Basic Troubleshooting Procedures ........................................................................... 47 
Advanced Troubleshooting Procedures .................................................................... 49 

Troubleshooting Physical Network Problems ...................................................... 49 
Troubleshooting Configuration Problems ............................................................ 50 

Determining Your IP Address ........................................................................ 50 
Troubleshooting Software-Interaction Problems ................................................. 54 

Specific Troubleshooting Procedures ........................................................................ 54 
Unable to Log In to EMTA ................................................................................... 55 
Local Networked Devices Unable to Access the EMTA ...................................... 55 
Unable to Access the Internet ............................................................................. 56 
Unable to Access Networked Devices ................................................................. 57 
Using the Ping Utility to Troubleshoot ................................................................. 57 

Testing the Path from a Computer to the EMTA ........................................... 57 
Testing the Path from a Computer to the Internet ......................................... 59 
Using Ping on a Macintosh ............................................................................ 59 

EMTA Disconnects from the Internet ................................................................... 60 
Slow Web Browsing ............................................................................................. 61 
Unable to Configure Port Forwarding .................................................................. 61 
EMTA is Not Passing DHCP Address to a computer .......................................... 62 
Determining a Computer’s MAC Address ............................................................ 62 

Microsoft Windows ........................................................................................ 62 
Apple Macintosh Windows OS X ................................................................... 63 

Appendix A - Glossary .......................................................................................... 64 

Appendix B - Compliance ..................................................................................... 65 

Index ....................................................................................................................... 67 



 
 

v 
D3CM1604V EMTA Cable Modem Administrator Manual 

Preface 

The D3CM1604V EMTA Cable Modem is ideal all-in-one wired solution for the home or 
business environment. SMC is proud to provide you with a powerful, yet simple 
communication device for connecting your local-area network (LAN) to the Internet. 

This Administrator manual contains all the information you need to install and configure your 
new D3CM1604V EMTA Cable Modem. 
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Key Features 
The following list summarizes the EMTA’s key features. 

ü Integrated, CableLabs-compliant DOCSIS 1.1/ 2.0 /3.0 cable modem. 

ü Integrated cable modem port for Internet connection to cable modem service. 

ü One 10/100/1000 Mbps Auto-Sensing LAN ports with Auto-MDI/MDIX. 

ü Dynamic Host Configuration Protocol (DHCP) for dynamic IP configuration, and Domain 
Name System (DNS) for domain name mapping. 

ü Two Plain Old Telephone System (POTS) RJ-11 telephone ports to allow Public Switch 
Telephone Network (PSTN) analog phone connections. 

ü Advanced SPI firewall EMTA for enhanced network security from attacks over the 
Internet: 

– Firewall protection with Stateful Packet Inspection 

– Client privileges 

– Hacker prevention 

– Protection from denial of service (DoS) attacks 

– Network Address Translation (NAT) 

ü Effortless plug-and-play installation. 

ü Intuitive graphical user interface (GUI) configuration, regardless of operating system. 

ü Comprehensive front panel LEDs for network status and troubleshooting. 

ü Compatible with all popular Internet applications. 
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Document Organization 
This document consists of five chapters and two appendixes. 

ü Chapter   1 – describes the contents in the EMTA package, system requirements, and an 
overview of the EMTA’s front, rear, top, and bottom panels. 

ü Chapter  2 – describes how to install the EMTA. 

ü Chapter  3 – describes how to configure TCP/IP settings on the computer you will use to 
configure the EMTA. 

ü Chapter  4 – describes how to configure the EMTA. 

ü Chapter  5 – provides troubleshooting information you can use in the unlikely event you 
encounter a problem with the EMTA. 

ü  Appendix A - is a glossary that defines the technical terms in this document. 

ü  Appendix B - contains compliance information.  

Document Conventions 
This document uses the following conventions to draw your attention to certain information. 

Safety and Warnings 

This document uses the following symbols to draw your attention to certain information. 

 
Symbol Meaning Description 

 
Note Notes emphasize or supplement important points of the main text. 

 
Tip Tips provide helpful information, guidelines, or suggestions for performing tasks more 

effectively. 

 
Warning Warnings indicate that failure to take a specified action could result in damage to the 

device. 

 
Electric Shock Hazard This symbol warns users of electric shock hazard. Failure to take appropriate 

precautions such as not opening or touching hazardous areas of the equipment could 
result in injury or death. 
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Typographic Conventions 
This document also uses the following typographic conventions. 

 
Convention Description 

Bold Indicates text on a window, other than the window title, including menus, menu options, buttons, fields, and labels. 

Italic Indicates a variable, which is a placeholder for actual text provided by the user or system. Angled brackets (< >) 
are also used to indicate variables. 

screen/code Indicates text that is displayed on screen or entered by the user. 

< > angled 
brackets 

Indicates a variable, which is a placeholder for actual text provided by the user or system. Italic font is also used to 
indicate variables. 

[ ] square 
brackets 

Indicates optional values. 

{ } braces Indicates required or expected values. 

| vertical bar  Indicates that you have a choice between two or more options or arguments. 
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1 Getting to Know the EMTA 

Before you install your D3CM1604V EMTA Cable Modem, check the package contents and 
become familiar with the EMTA’s front and back panels. 

The topics covered in this chapter are: 

ü Unpacking Package Contents (page 10) 

ü System Requirements (page 10) 

ü Front Panel (page 11) 

ü Rear Panel (page 12) 

ü Using the Reset Button (page 15) 
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Unpacking Package Contents  

Unpack the items in your D3CM1604V EMTA Cable Modem contents and confirm that no 
items are missing or damaged. Your package should include: 

ü One D3CM1604V EMTA Cable Modem 

ü One Category 5E Ethernet cable 

ü One power supply 

ü One set of quick-installation instructions 

If any items are missing or damaged, please contact your cable service provider. Keep the 
carton, including the original packing material, in case you need to store the product or 
return it. 

System Requirements  

To complete your installation, you need the following items:  

ü Provisioned Internet access on a cable network that supports cable modem service. 

ü A computer with a wired network adapter with TCP/IP installed. 

ü A Java-enabled Web browser, such as Microsoft Internet Explorer 5.5 or above. 

ü Microsoft® Windows® 2000 or higher for USB driver support. 

ü An analog telephone and two RJ-11 cables if you want to connect the EMTA to an 
analog telephone and PSTN telephone line. 
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Front Panel 

The front panel of your D3CM1604V EMTA Cable Modem contains a set of light-emitting 
diode (LED) indicators. These LEDs show the status of the EMTA and simplify 
troubleshooting.  

Figure  1-1 shows the front panel of the D3CM1604V EMTA Cable Modem. Table 1 
describes the front panel LEDs. 

 

Figure  1-1. Front Panel of the D3CM1604V EMTA Cable Modem 
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Table 1. Front Panel LEDs  

Symbol LED Color Description 

 

POWER  OFF = DC power is not supplied to the EMTA. 

Green ON = DC power is supplied to the EMTA and power switch is in the 
ON position. 

 

DS Blue Blinking = scanning for downstream channel. 
ON = locked on DOCSIS 3.0 downstream channel. 
OFF = no power. 

Green On = locked on DOCSIS 2.0 downstream channel. 

 

US Blue Blinking = ranging is in progress. 
ON = ranging is complete, DOCSIS 3.0 bonded upstream. 
OFF = no power or not locked on upstream channel. 

Green ON = ranging is complete, DOCSIS 2.0 bonded upstream. 

 

ONLINE Blue Blinking = DHCP and registration in progress. 
ON = online in DOCSIS 3.0 mode. 
OFF = no power or upstream ranging not complete. 

Green ON = online in DOCSIS 2.0 mode 

 

LINK Blue Blinking = data activity. 
ON = Gigabit Ethernet LAN device connected. 
OFF = no LAN devices connected. 

Green Blinking = data activity. 
ON = 10/100 Ethernet LAN device connected. 

 

Tel1 White Blinking = telephone line 1 is in use. 
ON = EMTA’s telephone 1 port is online. 
OFF = EMTA’s telephone 1 port is not online. 

 

Tel2 White Blinking = telephone line 2 is in use. 
ON = EMTA’s telephone 2 port is online. 
OFF = EMTA’s telephone 2 port is not online. 
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Rear Panel 

The rear panel of your D3CM1604V EMTA Cable Modem contains a reset button and the 
ports for attaching the supplied power adapter and making additional connections. Figure 
 1-2 shows the rear panel components and Table 2 describes their meanings. 

 

 

Figure  1-2. Rear View of the D3CM1604V EMTA Cable Modem 

 

 

 

 

 
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Table 2. D3CM1604V EMTA Cable Modem Rear Panel Components 

 Label Description 

 and  TEL1 and TEL2 Connect an analog telephone to one port and an analog (PSTN) telephone line to the other 
port. 

 LAN One 10/100/1000 auto-sensing RJ-45 switch port. Connect a device on your LAN such as a 
computer, hub, or switch to these ports. 

 RST Use this button to reset the power or restore the default factory settings (see “Using the Reset 
Button” on page 15). 

 CABLE Connect your coaxial cable line to this port. 

 POWER Connect the supplied power cord. 
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Using the Reset Button 
Using the reset button on the rear panel (see Figure  1-2 on page 13), you can perform two 
types of reset operations with the EMTA: 

ü Software reset – this reset operation power-cycles the EMTA and retains its current 
configuration settings. 

ü Factory default reset – this operation removes all overrides made to the EMTA’s factory 
default configuration and returns the EMTA to its original factory default settings. 

The number of seconds you press the reset button determines which reset operation is 
performed. To protect against accidental resets, the reset button is recessed on the EMTA 
rear panel. 

  

 
Note: You can also reset the EMTA and retain its current configuration settings using the 
RESET method described under “Configuring Security Settings” on page 40. 

To use the reset button to perform a software or factory default reset: 

1. Leave power plugged into the EMTA. 

2. Find the reset button at the top of the back panel, then use a thin object to press and hold 
the reset button as follows: 

– To perform a software reset, press the reset button for at least 10 seconds. 

– To perform a factory default reset, press the reset button for at least 15 seconds. 

3. Release the reset button. 
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2 Installing the EMTA 

This chapter describes how to install your D3CM1604V EMTA Cable Modem. The topics 
covered in this chapter are: 

ü Finding a Suitable Location (page 17) 

ü Connecting to the LAN (page 18) 

ü Connecting the WAN (page 19) 

ü Connecting to the Public Telephone Network (page 19) 

ü Powering on the EMTA (page 20) 
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Finding a Suitable Location 

Your D3CM1604V EMTA Cable Modem can be installed in any location with access to the 
cable network. All of the cables connect to the rear panel of the EMTA for better organization 
and utility. The LED indicators on the front panel are easily visible to provide you with 
information about network activity and status. 

For optimum performance, the location you choose should: 

ü Be close to a working AC power outlet when powering the EMTA using AC power. 

ü Allow at least one foot of space around the sides and top of the EMTA to provide 
sufficient air flow around the device. 

ü Not expose the EMTA to a dusty or wet environment. 

ü Be an elevated location such as a high shelf, keeping the number of walls and ceilings 
between the EMTA and your other devices to a minimum. 

ü Be away from electrical devices that are potential sources of interference, such as ceiling 
fans, home security systems, microwaves, or the base for a cordless phone. 

ü Be away from any large metal surfaces, such as a solid metal door or aluminum studs. 
Large expanses of other materials such as glass, insulated walls, fish tanks, mirrors, 
brick, and concrete can also affect your wireless signal. 

ü Should allow the EMTA to connect to an AC outlet that is not controlled by a wall switch. 
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Connecting to the LAN 

Using an Ethernet LAN cable, you can connect the EMTA to a desktop computer, notebook, 
hub, or switch. The EMTA supports auto-MDI/MDIX, so you can use either a standard 
straight-through or crossover Ethernet cable. 

1. Connect either end of an Ethernet cable to the LAN port on the rear panel of the EMTA 
(see Figure  2-1). 

 

Figure  2-1. Connecting to an Ethernet Port on the EMTA Rear Panel 

2. Connect the other end of the cable to your computer’s network-interface card (NIC) or to 
another network device (see Figure  2-2). 

 

Figure  2-2. Connecting the EMTA to the a Laptop or Desktop Computer 
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Connecting the WAN 

To connect the EMTA to a Wide Area Network (WAN) interface: 

1. Connect a coaxial cable to the port labeled CABLE on the rear panel of the EMTA from a 
cable port in your home or office (see Figure  1-2 on page 13). Use only manufactured 
coaxial patch cables with F-type connectors at both ends for all connections. 

2. Hand-tighten the connectors to secure the connection. 

3. If the modem was not installed by your cable provider (ISP) or is replacing another cable 
modem, contact your cable operator to register the D3CM1604V . If the modem is not 
registered with your cable operator, it cannot connect to the cable network system. 

Connecting to the Public Telephone Network 

The rear panel of the EMTA has two RJ-11 telephone-style connectors labeled TEL1 and 
TEL2. Each of these connectors can provide telephone service to multiple telephones, fax 
machines, and analog modems. 

The maximum number of telephone devices connected to each RJ-11 port is limited by the 
total Ringing Load of the telephone devices that are connected. Many telephone devices are 
marked with a Ringer Equivalent Number (REN). Each telephone port on the EMTA can 
support up to a 5 REN load. The sum of the REN load on all of the telephone devices 
attached to each port must not exceed 5 REN. 

Before you use the EMTA’s RJ-11 connectors to power the analog devices in your home or 
office, disconnect the telephone lines from any other provider at the demarcation point. If the 
incoming phone line is connected to another provider, such as an incumbent telephone 
company, it can result in potentially harmful voltage to the analog telephone line. 

  

 
Note: The customer or the customer's wire contractor is responsible for adhering to all local 
codes for wiring. 

To set up the ability to place calls using a regular analog telephone line (PSTN), perform the 
following procedure. 

1. Disconnect the phone lines from any other provider at the demarcation point, if appropriate. 

2. Connect the RJ-11 cable on an analog device to the TEL1 connector on the rear panel of 
the EMTA. 

3. Connect the RJ-11 cable on another analog device to the TEL2 connector on the rear 
panel of the EMTA. 
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Powering on the EMTA 

After making your connections, use the following procedure to power on the EMTA: 

1. Connect the supplied power cord to the power port on the rear panel of the EMTA (see 
Figure  1-2 on page 13).  

2. Connect the other end of the power adapter to a working power outlet. The EMTA powers 
on automatically, the POWER LED on the front panel goes ON, and the other front panel 
LEDs show the EMTA’s status (see Table 1 on page 12). 

  

 
WARNING: Only use the power supply supplied with the EMTA. Using a different power 
supply can damage the EMTA and void the warranty. 
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3 Preconfiguration Guidelines 

After you install your D3CM1604V Wireless EMTA Cable Modem, use the information in this 
chapter to configure the TCP/IP settings on the computer that is used to configure the 
EMTA. This chapter also covers other preconfiguration guidelines you should review before 
configuring the EMTA. 

The topics covered in this chapter are: 

ü Configuring Your Computer for TCP/IP (page 22) 

ü Disabling Proxy Settings (page 31) 

ü Disabling Firewall and Security Software (page 32) 

ü Confirming the EMTA’s Online Status (page 32) 

ü Confirming Your Computer’s Link Status (page 32) 
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Configuring Your Computer for TCP/IP 

Before you configure the EMTA using its Web management interface, configure TCP/IP 
settings on the computer that is used to configure the EMTA. The TCP/IP procedure to use 
depends on the operating system installed on the computer. 

ü For Microsoft Windows 2000, see the procedure below 

ü For Microsoft Windows XP, see page 23 

ü For Microsoft Windows Vista, see page 24 

ü For Microsoft Windows 7, see page 27 

ü For Apple Macintosh, see page 30 

Configuring Microsoft Windows 2000 

Use the following procedure to configure your computer if your computer has Microsoft 
Windows 2000 installed. 

1. On the Windows taskbar, click Start, point to Settings, and then click Control Panel. 

2. In the Control Panel window, double-click the Network and Dial-up Connections icon. If 
the Ethernet adapter in your computer is installed correctly, the Local Area Connection 
icon appears. 

3. Double-click the Local Area Connection icon for the Ethernet adapter connected to the 
EMTA. The Local Area Connection Status dialog box appears (see Figure  3-1). 

 

Figure  3-1. Local Area Connection Status Window 
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4. In the Local Area Connection Status dialog box, click the Properties button. The Local 
Area Connection Properties dialog box appears. 

5. In the Local Area Connection Properties dialog box, verify that Internet Protocol (TCP/IP) 
is checked. Then select Internet Protocol (TCP/IP) and click the Properties button. 

6. Click Obtain an IP address automatically to configure your computer for DHCP.  

7. Click the OK button to save this change and close the Local Area Connection Properties 
dialog box. 

8. Click the OK button again to save these new changes. 

9. Restart your computer. 

Configuring Microsoft Windows XP 

Use the following procedure to configure your computer if your computer has Microsoft 
Windows XP installed. If you use the Classic interface, where the icons and menus resemble 
previous Windows versions, perform the procedure under “Configuring Microsoft Windows 
2000” on page 22. 

1. On the Windows taskbar, click Start, click Control Panel, and then click Network and 
Internet Connections. 

2. Click the Network Connections icon. 

3. Click Local Area Connection for the Ethernet adapter connected to the EMTA. The Local 
Area Connection Status dialog box appears. 

4. In the Local Area Connection Status dialog box, click the Properties button (see Figure 
 3-2). The Local Area Connection Properties dialog box appears. 

 

Figure  3-2. Local Area Connection Status Window 
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5. In the Local Area Connection Properties dialog box, verify that Internet Protocol (TCP/IP) 
is checked. Then select Internet Protocol (TCP/IP) and click the Properties button. The 
Internet Protocol (TCP/IP) Properties dialog box appears. 

6. In the Internet Protocol (TCP/IP) Properties dialog box, click Obtain an IP address 
automatically to configure your computer for DHCP. Click the OK button to save this 
change and close the Internet Protocol (TCP/IP) Properties dialog box. 

7. Click the OK button again to save your changes. 

8. Restart your computer. 

Configuring Microsoft Windows Vista 

Use the following procedure to configure a computer running Microsoft Windows Vista with 
the default interface. If you use the Classic interface, where the icons and menus resemble 
previous Windows versions, perform the procedure under “Configuring Microsoft Windows 
2000” on page 22. 

1. On the Windows taskbar, click Start, click Control Panel, and then select Network and 
Internet Icon. 

2. Click View Networks Status and tasks and then click Management Networks 
Connections. 

3. Right-click the Local Area Connection icon and click Properties. 

4. Click Continue. The Local Area Connection Properties dialog box appears. 

5. In the Local Area Connection Properties dialog box, verify that Internet Protocol 
(TCP/IPv4) is checked. Then select Internet Protocol (TCP/IPv4) and click the 
Properties button (see Figure  3-3). The Internet Protocol Version 4 Properties dialog box 
appears. 
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Figure  3-3. Local Area Connection Properties Window 
 

6. In the Internet Protocol Version 4 Properties dialog box, click Obtain an IP address 
automatically to configure your computer for DHCP (see Figure  3-4).  

 

Figure  3-4. Internet Protocol Properties Window 
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7. Click the OK button to save your changes and close the dialog box. 

8. Click the OK button again to save your changes. 

 

Figure  3-5. Local Area Connection Status Window 
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Configuring Microsoft Windows 7 

Use the following procedure to configure a computer running Microsoft Windows 7. 

1. In the Start menu search box, type: ncpa.cpl 

 

Figure  3-6. Typing ncpa.cpl in the Start Menu Box 

The Network Connections List appears. 

 

Figure  3-7. Example of Network Connections List 

2. Right-click the Local Area Connection icon and click Properties. 

3. In the Networking tab, click either Internet Protocol Version 4 (TCP/IPv4) or Internet 
Protocol Version 6 (TCP/IPv6), and then click Properties. 
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Figure  3-8. Local Area Network Connection Properties Dialog Box 

4. In the properties dialog box, click Obtain an IP address automatically to configure your 
computer for DHCP (see Figure  3-9).  
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Figure  3-9. Properties Window 

5. Click the OK button to save your changes and close the dialog box. 

6. Click the OK button again to save your changes. 
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Configuring an Apple® Macintosh® Computer 

The following procedure describes how to configure TCP/IP on an Apple Macintosh running 
Mac OS 10.2. If your Apple Macintosh is running Mac OS 7.x or later, the steps you perform 
and the screens you see may differ slightly from the following. However, you should still be 
able to use this procedure as a guide to configuring your Apple Macintosh for TCP/IP. 

1. Pull down the Apple Menu, click System Preferences, and select Network.  

2. Verify that the NIC connected to the D3CM1604V is selected in the Show field. 

3. In the Configure field on the TCP/IP tab, select Using DHCP (see Figure  3-10). 

4. Click Apply Now to apply your settings and close the TCP/IP dialog box. 

 

Figure  3-10. Selecting Using DHCP in the Configure Field 
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Disabling Proxy Settings 

Disable proxy settings in your Web browser. Otherwise, you will not be able to view the 
EMTA’s Web-based configuration pages. 

Disabling Proxy Settings in Internet Explorer 

The following procedure describes how to disable proxy settings in Internet Explorer 5 and 
later.  

1. Start Internet Explorer. 

2. On your browser’s Tool menu, click Options. The Internet Options dialog box appears. 

3. In the Internet Options dialog box, click the Connections tab. 

4. In the Connections tab, click the LAN settings button. The Local Area Network (LAN) 
Settings dialog box appears. 

5. In the Local Area Network (LAN) Settings dialog box, uncheck all check boxes. 

6. Click OK until the Internet Options window appears. 

7. In the Internet Options window, under Temporary Internet Files, click Settings. 

8. For the option Check for newer versions of stored pages, select Every time I visit the 
webpage. 

9. Click OK until you close all open browser dialog boxes. 

Disabling Proxy Settings in Firefox 

The following procedure describes how to disable proxy settings in Firefox. 

1. Start Firefox. 

2. On your browser’s Tools menu, click Options. The Options dialog box appears. 

3. Click the Advanced tab.  

4. In the Advanced tab, click the Network tab. 

5. Click the Settings button. 

6. Click Direct connection to the Internet. 

7. Click the OK button to confirm this change. 
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Disabling Proxy Settings in Safari 

The following procedure describes how to disable proxy settings in Safari. 

1. Start Safari. 

2. Click the Safari menu and select Preferences. 

3. Click the Advanced tab.  

4. In the Advanced tab, click the Change Settings button. 

5. Choose your location from the Location list (this is generally Automatic). 

6. Select your connection method. If using a wired connection, select Built-in Ethernet. For 
wireless, select Airport.  

7. Click the Proxies tab.  

8. Be sure each proxy in the list is unchecked.  

9. Click Apply Now to finish. 

Disabling Firewall and Security Software 

Disable any firewall or security software that may be running on your computer. For more 
information, refer to the documentation for your firewall. After you configure the EMTA, 
please re-enable your computer firewall. 

Confirming the EMTA’s Online Status 
Confirm that the Online LED on the EMTA front panel is ON (see Figure  1-1 on page 11). If 
the LED is OFF, replace the coaxial cable connecting the EMTA to the cable service. If the 
Online LED does not go ON after several minutes, please contact your cable provider to 
confirm that the service is active. 

Confirming Your Computer’s Link Status 

Be sure there is an Ethernet cable connecting your computer to the EMTA. Then confirm 
that the LEDs for the EMTA port connected to your computer are blinking. If the LEDs are 
OFF, the connection between your computer and EMTA is not working properly. 
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4 Configuring the EMTA 

After configuring your computer for TCP/IP and following the preconfiguration guidelines in 
Chapter  3, use that computer’s Web browser to configure your D3CM1604V EMTA. This 
chapter describes how to use your computer’s Web browser to configure the EMTA.  

The topics covered in this chapter are: 

ü Accessing the EMTA’s Web Management (page 34) 

ü Understanding the Web Management Interface (page 35) 

ü Web Management Interface Menus (page 36) 
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Accessing the EMTA’s Web Management 

After configuring your computer for TCP/IP and reviewing the guidelines on the previous 
page, configure the EMTA using its Web-based management interface. From your Web 
browser, log in to the interface to define system parameters, change password settings, view 
status windows to monitor network conditions, and control the EMTA and its ports. 

To display the D3CM1604V EMTA Cable Modem ’s Web-based management screens, use 
the following procedure. 

1. Launch a Web browser.  

  

 
Note: Your computer does not have to be online to configure the EMTA. 

2. In the browser address bar, type http://192.168.100.1 and press the Enter key.  

3. When the Login screen appears, enter the default username and default password 
furnished by SMC Networks. The default login is:  

– Username: MSO 

– Password: Admin 

Both are case sensitive. For security, each password character is masked as a dot (●). 

  

 
Note: Your cable modem operator may customize the login password, so please check with 
your operator for the correct password to use. 

4. Click the LOGIN button to access the EMTA’s Web interface. The Connection page 
appears, showing information about the status of the cable modem's HFC and IP network 
connectivity. You can also display this page any time by clicking Status > Connection in 
the menu bar. 

  

 
Tip: For security purposes, we recommend you change the login password after logging in to 
the Web management interface for the first time (see “Configuring Security Settings” on page 
40). 

http://192.168.100.1/
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Understanding the Web Management Interface 

The top and left sides of the Web management interface contain menus and submenus for 
selecting pages to configure the EMTA. When you click a menu at the top, a set of 
submenus appear at the left side. The configuration settings associated with the currently 
selected submenu appear in the workspace (see Figure  4-1).  

 

Figure  4-1. Main Areas on the Web Management Interface 

 
  

Submenus 

Workspace 

Menus 
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Web Management Interface Menus 

Table 3 describes the menus in the Web management interface.  

Table 3. Web Management Interface Menus and Submenus 

Menus and Submenus Description See Page 

Status > About Shows information about the current system software. 37 

Status > Connection Shows the status of the cable modem's HFC and IP network 
connectivity. 

38 

Status > Security Configures administration access privileges and the ability to restore 
factory defaults to the system. 

40 

MTA > Status Shows initialization status of the MTA. 41 

MTA > DHCP Shows the MTA DHCP lease information. 42 

MTA > QoS Shows the MTA QoS parameters. 43 

MTA > Provisioning Shows the MTA provisioning information. 44 

MTA > Event Log Shows the MTA event log. 45 
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Viewing System Software Settings 
Path: Status > About 

 

The Software page shows information about the current system software. The information is 
organized into the following sections:  

ü Information 

Shows the EMTA’s DOCSIS-compliance information, hardware and software 
versions, and the cable modem Media Access Control (MAC) address, serial 
number, and certificate. 

ü Status 

Shows how long the EMTA has been operational, whether network access is 
allowed, and the cable modem IP address. 
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Viewing Network Connectivity 
Path: Status > Connection 

 

The Connection page shows information about the status of the cable modem's HFC and IP 
network connectivity. The information is organized into the following sections:  

ü Startup Procedure 

Shows the procedures performed by the EMTA at startup, their status, and 
any comment associated with the procedures. 

ü Downstream Bonded Channels 

Shows the channel, lock status, modulation, channel ID, frequency, power, 
signal-to-noise ratio (SNR), and total correctables and uncorrectables. 

ü Upstream Bonded Channels 

Shows the channel, lock status, US channel type, channel ID, symbol rate, 
frequency, and power. 

ü CM IP Address 

Shows the cable modem IP address duration and expiration date/time. 

ü Frequency Select (DS1) 

Lets you set the frequency to be used for communications over Digital Signal 
1 (DS1). Click TUNE to apply your setting. 

ü Current system date and time. 
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Configuring Security Settings 
Path: Status > Security 

 

The Security page lets you change the user ID and password you use to log on to the Web 
management interface, enable or disable the EMTA’s firewall, and restore the EMTA to its 
factory default settings. After you enter your security settings on this page, click Apply to 
have them take effect. 

 

 

Option Description 

Password Change User ID To change your logon user ID, enter the new logon user ID.  

New Password To change your logon password, enter the new case-sensitive password. For security, each 
typed password character is masked as a dot (●). 

Re-Enter New Password Re-enter the same case-sensitive password you entered in the New Password field. For 
security, each typed password character is masked as a dot (●). 

Current User ID Password To change your logon user ID, enter your current logon user ID. 

Firewall Protection Enables or disables the EMTA’s built-in firewall. 

Restore Factory Defaults Restores the EMTA to its factory default settings. Any factory default settings you changed 
will be discarded. 

Apply button Click this button to save the settings you entered on this page. 
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Viewing the MTA Initialization Status 
Path: MTA > Status 

 

The Status page displays initialization status information about the EMTA’s multimedia 
terminal adapter (MTA). The information is organized into the following sections: 

ü Startup Procedure = shows the tasks performed at startup and their status. 

ü MTA Line State = shows the state of Line 1 (TEL1) and Line 2 (TEL2). 
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Viewing DHCP Information 
Path: Path > DHCP 

 

The DHCP page shows MTA Dynamic Host Configuration Protocol (DHCP) lease 
information. The information is organized into the following sections: 

ü Lease Parameters 

Shows the fully qualified domain name (FQDN), IP address and submask 
information, bootfile path, and IP addresses for the primary and secondary 
Domain Name Systems (DNS). 

ü Lease Timers 

Shows the amount of time remaining for the DHCP lease, rebind, and renew. 

ü Packetable DHCP Option 122 

Shows PacketCable DHCP Option 122, which provides the MTA with a list of 
PacketCable DHCP servers from which the MTA is allowed to accept DHCP 
offers, as specified in RFCs 3495 and 3594. 
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Viewing Quality of Service Information 
Path: Path > QoS 

 

The QoS page shows MTA QoS settings. The information is organized into the following 
sections: 

ü Error Codewords 

Shows the number of code words that had no errors, errors that were 
corrected, and errors that could not be corrected. 

ü Payload header Suppression 

Shows whether the Payload Header Suppression (PHS) status is ON or OFF. 

ü Service Flows 

Shows PacketCable DHCP Option 122, which provides the MTA with a list of 
PacketCable DHCP servers from which the MTA is allowed to accept DHCP 
offers, as specified in RFCs 3495 and 3594. 
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Viewing Provisioning Information 
Path: Path > Provisioning 

 

The Provisioning page shows MTA provisioning information. The information is organized 
into the following sections: 

ü MTA Config File 

Shows the filename and contents of the MTA configuration file. 

ü Enterprise MIBs 

Shows the Object Identifiers (OIDs) and their corresponding values in the 
enterprise Management Information Bases (MIBs). 
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Viewing the Event Log 
Path: Path > Event Log 

 

The Event Log page shows the time, priority, ID, and text description of system events. This 
page can be very useful, as it shows what has happened to the EMTA since power on.  

All entries are date and time stamped The log space is used in a cyclic manner, with the 
most recent entry at the top. 
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5 Troubleshooting Procedures 

Successful troubleshooting requires a logical, consistent approach that narrows down the 
source of a problem by ascertaining what is and isn't working until a single cause is 
identified. This chapter provides suggestions for identifying and resolving problems in the 
unlikely event you encounter a problem using the EMTA. It also provides tips for tuning your 
configuration to optimize your wired and wireless networking experience. 

The topics covered in this chapter are: 
 

Topic Subtopics 

Basic Troubleshooting Procedures See page 47 

Advanced Troubleshooting Procedures • Troubleshooting Physical Network Problems (page 49) 

• Troubleshooting Configuration Problems (page 50) 

• Determining Your IP Address (page 50) 

• Troubleshooting Software-Interaction Problems (page 54) 

Specific Troubleshooting Procedures • Unable to Log In to  (page 55) 

• Local Networked Devices Unable to Access the  (page 55) 

• Unable to Access the Internet (page 56) 

• Unable to Access Networked Devices (page 57) 

• Using the Ping Utility to Troubleshoot (page 57) 

• EMTA Disconnects from the Internet (page 60) 

• Slow Web Browsing (page 61) 

• Unable to Configure Port Forwarding (page 61) 

• EMTA is Not Passing DHCP Address to a computer (page 62) 

• Determining a Computer’s MAC Address (page 62) 
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Basic Troubleshooting Procedures 

The following covers basic troubleshooting procedures. Carefully review the sections to 
make sure you follow the recommended procedures. 

Always start your network using the following sequence 

1. Unplug the EMTA and any other routers or switches.  

2. Shut down connected computers.  

3. Plug in the EMTA first and wait for the lights to cycle through the startup routine. This 
prevents another device from taking the DHCP lease. 

4. Plug in any other routers and switches. 

5. Start up your computer. 

Check basic EMTA functions 

After you turn on power to the EMTA, check that the following LED sequences have 
occurred (and see “Front Panel” on page 11): 

1. When power is first applied, verify that the POWER LED is ON. 

2. After about a minute, verify the statuses of the following LEDs on the front panel of the 
EMTA (see Figure  1-1 on page 11): 

ü ONLINE = ON (EMTA is operational) 

ü DS = ON (EMTA is connected to the Internet) 

ü US = ON (EMTA is connected to the Internet) 

If this behavior does not occur, see Table 4. If the incorrect behavior persists, use the Reset 
button to return the EMTA to its factory default configuration settings (see “Using the Reset 
Button” on page 15). 
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Table 4. Checking Basic EMTA Functions  

If… Perform This Procedure 

The POWER and other LEDs are OFF. 1. Turn off the EMTA and then turn it on again to see whether the problem is 
resolved. 

2. Check that you are using the power adapter supplied with the EMTA. 
3. Be sure the power cord is connected to the EMTA and to a functioning power 

outlet. 
4. Plug a working device, such as a lamp, into the power outlet to confirm that the 

outlet is working. 
5.  Be sure the power outlet is not controlled by a wall switch that can inadvertently 

remove power from the outlet. 

The DS and US LEDs are OFF. 1. Be sure the Ethernet cable connections are secure at the EMTA and at the 
computer. 

2. Be sure that power is turned on to the computer connected to the EMTA. 
3. Be sure you are using the Ethernet cable supplied with the EMTA or one 

configured similarly to it. 

Check the EMTA’s telephone interfaces 

To confirm that the EMTA’s two telephone interfaces are working properly:  

1. Lift the handset of the device connected to the EMTA’s telephone 1 interface, and confirm 
that the Tel1 LED goes ON. Hang up the device (place the device onhook) and confirm 
that the Tel1 LED goes OFF. 

2. Lift the handset of the device connected to the EMTA’s telephone 2 interface, and confirm 
that the Tel2 LED goes ON. Hang up the device (place the device onhook) and confirm 
that the Tel2 LED goes OFF. 
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Advanced Troubleshooting Procedures 

Most advanced troubleshooting procedures fall into one of the following categories: 

ü Physical - an underlying problem with cables, a bad EMTA, or similar hardware problem. 
See page 49. 

ü Configuration - a problem with the configuration of one or more of network components. 
See page 50. 

ü Software - a failure of one or more software applications, an undesired interaction 
between two or more applications, or an undesired application that has been introduced 
into the network. See page 54. 

Troubleshooting Physical Network Problems 

When you experience network troubles, start by checking the physical network devices and 
connections. These problems are the most easily fixed and include: 

ü Performing a thorough physical inspection of your network. 

ü Checking that all hardware devices, including the EMTA, are plugged in and physically 
connected to the network. 

ü Making sure you are using the proper network cables (for example, not using a 
crossover cable with a NIC that requires a straight-through cable). 

ü Making sure all network cables are in good condition and well seated. Often, reseating 
the cable into a connector is all that is required to ensure a firm connection. 

In addition, some operating systems, such as Microsoft Windows XP, show errors, such as 
when a network cable is unplugged. Figure 2, for instance, shows examples of how 
Microsoft Windows XP shows connection statuses in the Network Connections window. For 
information about other operating systems, refer to the documentation for those operating 
systems. 
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Connected. Your computer is properly connected to the EMTA or wired/wireless network, 
but there is a problem between the EMTA and the Internet. 

 

Disabled. Someone has manually disabled the NIC. To fix the problem, right-click the 
adapter and click Enable. 

 

Unplugged. Your computer cannot detect the connection to the EMTA. 

 

Not connected. Your computer cannot connect to your wireless network. 

 

Limited or no connectivity. Your computer is properly connected to the EMTA, but either the 
EMTA is misconfigured or there is a problem between the EMTA and the Internet. 

Figure  5-1. Examples of Connectivity Statuses for Microsoft Windows XP 

Troubleshooting Configuration Problems 

After confirming that your hardware is working properly, examine your networking 
configuration to determine whether there is a misconfiguration of IP addresses, subnet 
masks, EMTAs, or broadcast addresses. Common configuration problems can be caused by 
misconfiguring newly connected or configured devices. 

Determining Your IP Address 

An IP address uniquely identifies computers and computing devices, such as the EMTA, on 
a TCP/IP network. IP addresses are normally expressed in dotted-decimal format, with four 
numbers (or “octets”) separated by periods, such as 10.1.10.1. 

For troubleshooting purposes, all the numbers in the IP addresses of your networked 
devices must be consistent across the network. This means: 

ü The first nine numbers (i.e., the first three octets) in the IP addresses are the same for all 
the devices on the network. 

ü The last three numbers (i.e., the last octet) in the IP addresses are different and not in 
use by other devices on the network (assuming your subnet mask is 
255.255.255.000). 

For example, if the IP address for the EMTA is 10.1.10.1, the other devices on the network 
must have an IP address whose: 

ü First three octets are 10.1.10. 
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ü Last octet is any unique number from 0 to 255 (there are restrictions on using 0 and 255, 
so avoid using them). You would not use 1 as the last number, since that number is the 
last octet in the EMTA IP address in our example. 

Figure  5-2 shows an example of IP addresses assigned to devices on the network. 

 

Figure  5-2. Example of IP Addresses for Networked Devices 

You define the computer’s IP address using the procedure appropriate for your operating 
system, as described in Chapter  3. 

  

 
Tip: The following Windows sections describe how to use the command-line program 
Windows IP Configuration (ipconfig) to see the IP address of a computer running a Windows 
operating system. However, if you want even more information, such as IP routing and DHCP 
information, type ipconfig /all instead of ipconfig in the Windows sections that follow. 

The most common problem associated when viewing IP addresses is that either: 

ü A computer’s IP address is not on the same subnet as the other networked devices. In 
other words, the first nine numbers (three octets) in the device’s IP address are not 
identical to those of the other networked devices. 

ü A computer shows an IP address that starts with the digits 169.254. When this 
happens, it often means the computer could not retrieve a network address from a 
DHCP server and therefore automatically assigned itself an address from the base 
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network address 169.254. This would be fine if all the computers on your network used 
IP addresses from the 169.254 base network address. If one of them isn’t, however, 
that computer will have problems connecting to the other network computers. 

Possible causes for an IP address not being assigned are: 

 Defective cables. Replace the cable if it is worn or defective. 

 An Ethernet cable may not be firmly connected at both ends. Secure the cable at both 
ends. Often, just reseating the cable into a connector is all that is required. 

 The NIC may be bad or the network cable connected to it may be the wrong kind (for 
example, it might be a straight-through cable when a crossover cable is required). If you 
have another NIC and cable available, try using them instead. 

 The EMTA port may be bad. Plug the network cable into a different port on the EMTA. 

 The DHCP server that would automatically assign IP addresses is not configured for 
DHCP. 

 Wrong WEP or WPA settings are configured on the EMTA or access point for wireless 
connections. 

The sections that follow describe how to identify the IP addresses on devices running 
Windows and Macintosh operating systems. 

Microsoft Windows 2000 

To find the IP address of a computer running Microsoft Windows 2000: 

1. From the Windows task bar, click Start and select Run. 

2. In the Open field, type cmd and click OK. A DOS command window appears. 

3. In the DOS command window, type ipconfig and then press Enter. Your IP address will be 
listed (see Figure  5-3). 

4. When you finish, type exit at the command prompt and press Enter to close the window 

 

Figure  5-3. Example of an IP Address 

Sample IP Address 
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Microsoft Windows XP, Vista, and 7 

To find the IP address of a computer running Microsoft Windows XP, Vista, or 7: 

1. Click on Start and in the Start Search box type cmd.  

2. Press Enter on your keyboard or click cmd.exe in your search list (see Figure  5-4). 

 

Figure  5-4. Example of md.exe in the Search List 

3. In the DOS command window, type ipconfig and then press Enter. Your IP address will be 
listed (see Figure  5-3). 

4. When you finish, type exit at the command prompt and press Enter to close the window. 

Apple Macintosh OS X 

To find the IP address of a Mac OS X OS X 10.6 or 10.5 computer: 

1. From the Apple menu, select System Preferences...  

2. In System Preferences, from the View menu, select Network.  

3. In the Network preference window, click a network port (for example, Ethernet, AirPort, 
modem). If you are connected, the IP address appears below Status. 

4. Close the window when finished. 

To find the IP address of a Mac OS X 10.4 or 10.3 computer: 

1. From the Apple menu, select Location, and then Network Preferences...  
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2. In the Network Preference window, next to Show, select Network Status. Your network 
status and IP address appear. 

3. Close the window when finished. 

Via the Web 

There are various Web sites, such as http://whatismyipaddress.com/, that display your IP 
address and other information about your system. If the page does not display, you may not 
have a working Internet connection and should try one of the methods described above to 
find your IP address. 

Troubleshooting Software-Interaction Problems 

If the physical network and basic configuration procedures in the preceding sections do not 
resolve your problem, focus on software problems. The most common software problems 
are related to firewalls. 

Many third-party antivirus programs include built-in firewalls. You may not realize that you 
installed the firewall component when you installed the antivirus software, and now the 
firewall may be interfering with your network connectivity. 

To troubleshoot software problems: 

1. Disconnect your network from the Internet so that you can safely disable any firewalls or 
antivirus software while you troubleshoot.  

2. Disconnect the EMTA from the Internet and unplug the EMTA. 

3. After you are off the Internet, disable any antivirus or firewall programs you have, including 
Internet Connection Firewall or Windows Firewall, on all the computers that have problems. 
If this step solves the problem, the problem exists with one of these Windows features or 
products. Enable one at a time and see when things break again. When they do, you know 
where the problem is and you can either replace that product with one that does not cause 
problems or change the program's configuration to resolve the problem.  

4. When you have everything working, reconnect your devices to the Internet. 

5. Restart all your computers. 

Specific Troubleshooting Procedures 

The following sections cover specific troubleshooting suggestions you may find helpful if the 
basic and advanced troubleshooting procedures in the previous sections did not resolve 
your problem. 

http://whatismyipaddress.com/
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Unable to Log In to EMTA 

If you are unable to log in to the EMTA’s Web management interface: 

1. Confirm that the Ethernet cable connecting the computer and EMTA is connected securely 
at both ends. Often, just reseating the cable into a connector is all that is required. 

2. If you have more than one network port available on the EMTA, plug the cable into a 
different port. If the network connection works, the original port on the EMTA is faulty. 
However, you can continue to use the other ports. 

3. The NIC in your computer might have failed. If possible, connect a different computer to 
the same network cable. If the connection works, the problem is with the NIC. Contact the 
NIC manufacturer for support or install a new NIC. If the new computer also fails to 
connect, replace the Ethernet cable with a new cable, as you might have a faulty cable. If 
the problem persists, contact technical support for the EMTA. 

4. Be sure you are using the correct login information. 

Local Networked Devices Unable to Access the EMTA 

If devices on the local network cannot access the EMTA: 

1. Go to Status > Connection.  

2. Under the Startup Procedure, check for error statuses. If your statuses show no local 
network connection and/or no clients connected, proceed to the next step.<<true??>> 

3. Be sure the computer connected to the EMTA is configured to use the same subnet mask 
and EMTA settings as shown on the Status > DHCP page (see “Viewing DHCP 
Information” on page 42). 

4. Ping the EMTA from a computer on the same subnet as the EMTA (see “Testing the Path 
from a Computer to the EMTA” on page 57). If the ping fails and there is no firewall 
software installed, your network configuration, NIC, or cabling is probably at fault. 

5. Release and renew the NIC’s IP address: 

a. From the Windows task bar, click Start and select Run. 

b. In the Open field, type cmd and click OK. 

c. At the first command prompt, type ipconfig/release and press Enter. 

d. At the next command prompt, type ipconfig/renew and press Enter. 

e. Check whether your computer obtained an IP address other than 169.254.x.x or 
0.0.0.0. 

6. If the problem continues, power cycle the EMTA and computer: 

a. Turn off the computer and turn off EMTA. 

b. Turn on the EMTA and turn on computer. 
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7. For secured wireless connections, be sure you entered the correct security key when 
connecting to a secured wireless network. 

Unable to Access the Internet 

If the EMTA cannot access the Internet, it could be due to several reasons, such as a failed 
Internet connection, a misconfigured EMTA, or a misconfigured NIC. 

1. Unplug the EMTA. 

  

 
Note: If the EMTA is located where you cannot easily unplug it, you can restart it using the 
Restore / Reboot EMTA page (see “Configuring Security Settings” on page 40). 

2. Turn off the EMTA for three minutes. 

3. Turn off all computers attached to your network. 

4. Plug in the EMTA first, turn it on, and let it boot.  

5. After the EMTA completes its connection to the ISP, restart your computer. 

6. Check that the EMTA’s ONLINE LED is ON. If it is OFF, replace the coaxial cable 
connecting the EMTA to the cable service. If the ONLINE LED does not go ON after the 
EMTA has been powered up for several minutes, contact your cable provider to confirm 
that the service is active. 

7. If the ONLINE LED is ON, click Status > About and confirm that the Network field shows 
Active (see Viewing System Software Settings on age 37). If it doesn’t, contact your cable 
provider to confirm that the service is active. 

8. If you have more than one network port available on the EMTA, plug the cable into a 
different port. If the network connection works, the original port on the EMTA is faulty. 
However, you can continue to use the other ports. 

9. Close any network applications that you might have opened, especially file-sharing and 
peer-to-peer applications. These applications can consume large amounts of bandwidth 
that can prevent you from being able to browse the Web. 

10. Ping a location on the Internet (see “Testing the Path from a Computer to the Internet” on 
page 59). For example, ping www.yahoo.com. If the ping succeeds, proceed to the next 
step. If the ping fails: 

ü Your Web browser may be misconfigured. Be sure you do not have an incorrect proxy 
server setting in your Web browser. 

ü If your computer is running a Microsoft Windows operating system, check whether the 
computer has a corrupt winsock registry entry (refer to your Windows documentation). 

ü The site might be down. Try to ping another site. 

http://www.yahoo.com/
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ü If your additional pings fail, please contact technical support. 

11. Check your computer’s operating system to see whether the computer has connectivity (for 
example, see Figure  5-1 and refer to the documentation for your operating system). If it 
doesn’t, try using another computer and NIC attached to the EMTA to connect to the 
Internet. 

12. Try accessing the Internet with a different browser. If you succeed, the problem exists with 
the previous browser you used. 

Unable to Access Networked Devices 

If you are on a network, but cannot connect to any resources on the network: 

1. The Ethernet cable may be worn. Replace the cable if it is worn. 

2. The Ethernet cable may not be firmly connected at both ends. Secure the cable at both 
ends. Often, just reseating the cable into a connector is all that is required. 

3. The port on the EMTA may be bad. Plug the network cable into a different port on the 
EMTA. 

4. The NIC may be bad or the cable connected to the NIC may be the wrong kind of network 
cable (for example, you may be using a straight-through cable when a crossover cable is 
required). If you have another NIC available, try using it instead of the one currently used. 

5. Ping the IP address of other computers and devices on your network. 

6. For Windows operating systems: 

– Try connecting to a computer on the network using Start \ Run and enter \\PCname, 
where PCname is the name of the computer you want to connect to.  

– Add the computer and its IP address to the LMHOSTS file. This is a text file that 
resides in the Windows\System32\drivers\etc directory (for Windows2000 or 
XP) and has the format IP_Address Computer_Name. 

  

 
Tip: Browsing is a fairly complicated issue and has a lot of places for failure. If you need to 
have resources available, create shortcuts on your desktop instead. 

Using the Ping Utility to Troubleshoot 

You can use your computer’s ping utility to test the path from the computer to the EMTA and 
from your computer to the Internet. 

Testing the Path from a Computer to the EMTA 

You can ping the EMTA to verify that the LAN path from your computer to the EMTA is set 
up correctly. To ping the EMTA from a Windows computer: 
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1. From the Windows task bar, click Start and select Run. 

2. In the Open field, type ping followed by the IP address of the EMTA. 

3. Click OK. A message similar to the following appears (in this example, 192.168.0.1 is the 
IP address entered as part of the ping command): 

 Pinging 192.168.0.1 with 32 bytes of data 

If the destination IP address was contacted successfully, a message similar to the following 
appears: 
 Reply from 192.168.0.1: bytes=32 time=NN ms TTL=xxx 

If the path was not contacted successfully, a message similar to the following appears: 
 Request timed out 

If the path is not working properly: 

ü The physical connections may be wrong. Be sure the EMTA’s ONLINE LED is ON. If it is 
OFF, review “Basic ” on page 47. 

ü Check that the corresponding LEDs on the NIC installed in your computer are ON (refer 
to the documentation for your NIC). If they are OFF, verify that the Ethernet card driver 
software and TCP/IP software are both installed and configured properly on your 
computer.  

ü Verify that the IP addresses for the EMTA and your computer are correct and that both 
addresses are on the same subnet (for example, 192.168.1.x/255.255.255.0). 



Troubleshooting Procedures 

59 
D3CM1604V EMTA Cable Modem Administrator Manual 

Testing the Path from a Computer to the Internet 

After verifying that the path between your computer and EMTA is working properly, use the 
following procedure to test the path from your computer to the Internet. 

To test the path using ping from a Windows PC: 

1. From the Windows task bar, click Start and select Run. 

2. In the Open field, type cmd and click OK. A DOS command window appears. 

3. At the > prompt, type ping -n 10 IPaddress where IPaddress is the IP address of a 
remote device (such as your ISP’s server) or Web site (such as www.yahoo.com). 

4. Press Enter. If the path is working, a reply similar to the one in the previous section 
appears. If you do not receive replies: 

ü Confirm that your computer has the IP address of the EMTA listed as the default EMTA. 
If your computer’s IP address is obtained automatically through DHCP, this information 
will not be visible in your computer’s Control Panel. Verify that the EMTA’s IP address is 
shown as the TCP/IP default EMTA. 

ü Check whether your computer’s network address (the portion of the IP address specified 
by the netmask) is different than the network address of the remote device. 

5. When you finish, type exit at the command prompt and press Enter to close the window. 

Using Ping on a Macintosh 

To ping on a Macintosh: 

1. Click on Go > Applications > Utilities.  

2. Click on Network Utility, and then click the Ping tab. A page similar to the one in Figure 
 5-5 appears. 

3. In the first field, enter the IP address you want to ping. 

4. Using the options below the field, select an unlimited number of pings or send a specific 
number of pings. 

5. Click the Ping button. If you receive: 

ü reply from..., the destination IP address was contacted successfully.  

ü request timed out, the destination IP address was not contacted successfully. 

ü destination host unreachable, you are not on the same subnet as the destination 
address. Change your IP address to communicate with the destination address. 
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Figure  5-5. Ping Tab on the Network Utility Page 

EMTA Disconnects from the Internet 

If the EMTA has been connected to the Internet for an extended period and holds an IP 
address (DHCP lease) for a longer period of time than your ISP allows, it is not uncommon 
for the EMTA to disconnect from the Internet. This is normal and does not indicate any issue 
with the EMTA.  

1. Press the EMTA reset switch. 

  

 
Note: If your DHCP lease time seems to be extremely short, click MTA > DHCP and check 
the Lease Timer settings on the DHCP page (see Viewing DHCP Information” on page 42. 
Contact your ISP to determine whether there are other issues on the network. 

2. Connect a computer to one of the EMTA’s LAN ports. 

3. Restart your computer. 

4. Reset the EMTA to its factory default settings using either the Reset button (see “Using the 
Reset Button” on page 15) or the Restore Factory Defaults setting on the Security page 
(see “Configuring Security Settings” on page 40). 

  

 
Note: This step removes all overrides made to the EMTA’s default settings and returns the 
EMTA to its original factory default settings. 

In certain network scenarios, it may be helpful to turn off all the equipment on your network, 
and then turn the equipment all back on. Leaving some devices unplugged for up to five 
minutes can also help.  
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If the disconnections are limited to wired clients only 

Check your NIC settings and all cable routing, connections, and power supplies. 

If the disconnections are limited to wireless clients only 

Focus on factors that affect wireless clients, such as: 

ü Network selection and security 

ü Hardware access control 

ü Client TCP/IP settings 

ü Signal strength 

ü Sources of interference 

Can you connect to the Internet directly? 

1. Set up a computer to connect to the Internet directly, without using the EMTA. 

2. If you cannot connect to the Internet without the EMTA, contact your ISP for assistance. 

Slow Web Browsing 

If you experience slow Web browsing with the EMTA: 

1. Check for possible intrusions by spyware and viruses. 

2. Clear browser settings and cache (refer to the documentation for your Web browser). 

3. Stop other programs running in the background that are consuming bandwidth. 

4. A specific site may be suffering from server issues. Try another site. 

5. Update the EMTA firmware. 

Unable to Configure Port Forwarding 

If you are not able to configure port forwarding for software applications, external servers, or 
gaming: 

ü Ascertain the port(s) that the application or game calls for.  

ü Some ISPs block ports, such as ports 20, 21, and 80. Check with ISP to confirm whether 
it is blocking ports. 

ü Reserve IP addresses for the computers to ensure they receive the appropriate IP 
address(es) for the service created. 

ü Disable firewalls and stateful packet inspection (SPI) applications. 

ü Create a dynamic DNS (DynDNS) account for dynamic IP addresses from the ISP. 

ü Update the EMTA firmware. 
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EMTA is Not Passing DHCP Address to a computer 

If the EMTA is not passing DHCP addresses to a computer over a wired or wireless 
connection: 

1. Be sure the computer’s IP is not statically set already. 

2. Release and renew the NIC’s IP address: 

a. From the Windows task bar, click Start and select Run. 

b. In the Open field, type cmd and click OK. 

c. At the first command prompt, type ipconfig/release and press Enter. 

d. At the next command prompt, type ipconfig/renew and press Enter. 

3. For wired connections, be sure the physical cable connections are correct. 

Determining a Computer’s MAC Address 

The following sections describe how to obtain a computer’s MAC address. 

Microsoft Windows 

To determine the MAC address on a Windows computer: 

1. From the Windows task bar, click Start and select Run. 

2. In the Open field, type cmd and click OK. A DOS command window appears. 

3. In the DOS command window, type ipconfig/all and press Enter. 

4. This window displays your networking information. The MAC address appears as a 
Physical Address below Ethernet adapter Local Area Connection. In the example in 
Figure  5-6, the MAC address is 00-1E-8C-94-09-EA, which is the physical address of the 
NIC card.  

5. When you finish, type exit at the command prompt and press Enter to close the window. 
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Figure  5-6. Example of MAC Address 

Apple Macintosh Windows OS X 

To determine the MAC address on a Mac running OS X, perform the following procedure. 
The MAC address appears in the form of 00 0D 93 13 51 1A. 

1. From the dock, select System Preferences. 

2. Select Network, Select Location, Select Interface. 

3. Perform one of the following steps: 

ü For a wired Mac running Mac OS 10.2 or earlier, select the TCP/IP tab. The number next 
to the Ethernet Address is your MAC address. 

ü For a wired MAX running OS 10.3 and later), select the Ethernet tab. The number next 
to the Ethernet ID is your MAC address. 

ü For a wireless connection (AirPort), select AirPort tab. The number next to the AirPort 
ID is your MAC address. 

Sample IP Address 
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Appendix A -  Glossary 

 

Term Definition 

Correctables Number of codewords that were detected to be damaged, but could be repaired by the EMTA. 

Downstream The direction from the head-end toward the subscriber. The downstream channel carries data from 
the ISP's head end (UBR) to your EMTA. 

DS1 Digital Signal 1. A T-carrier signaling method that is widely used standard in telecommunications in 
North America and Japan to transmit voice and data between devices. 

EMTA Embedded Multimedia Terminal Adapter. A device that combines a DOCSIS cable modem and 
analog telephone adapter. The cable modem provides the data interface and the telephone 
adapter provides the voice over IP (VOIP) interface for one or more telephones. The terminal 
adapter provides the conversion between analog voice signals and IP packets, delivers dial tone, 
and manages the call setup. 

Payload Header Suppression A feature of DOCSIS 1.1 and 2.0 in which header bytes that are common in a sequence of packets 
of a Service Flow are replaced by a 1-byte PHSI Index (PHSI) when transmitting the packet on the 
RF network. 

Uncorrectables Number of codewords that were detected to be damaged beyond possibility of repair by the EMTA. 
If this count is increasing, the downstream signal conditions are unacceptable, regardless of how 
good the SNR and power figures look on the Connection page (see “Viewing Network Connectivity” 
on page 38). Uncorrectables disappear after a reboot because the EMTA resets its counters to 
zero without store that data permanently in its memory. 

Upstream The direction from the subscriber toward the head-end. The upstream channel carries data from 
your EMTA to the ISP's head-end. 
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Appendix B -  Compliance 

 

FCC Interference Statement 

This equipment has been tested and found to comply with the limits for a Class B digital device pursuant to Part 

15 of the FCC Rules. These limits are designed to provide reasonable protection against radio interference in a 

commercial environment. This equipment can generate, use and radiate radio frequency energy and, if not 

installed and used in accordance with the instructions in this manual, may cause harmful interference to radio 

communications. Operation of this equipment in a residential area is likely to cause interference, in which case 

the user, at his own expense, will be required to take whatever measures are necessary to correct the 

interference. If this equipment does cause harmful interference to radio or television reception, which can be 

determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one 

of the following measures: 

ü Reorient or relocate the receiving antenna. 

ü Increase the separation between the equipment and receiver. 

ü Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 

ü Consult the dealer or an experienced radio/TV technician for help. 

The device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This 

device may not cause harmful interference, and (2) this device must accept any interference received, including 

interference that may cause undesired operation. 

FCC Caution: Any changes or modifications not expressly approved by the party responsible for compliance 

could void the user’s authority to operate this equipment. 

IEEE 802.11b or 802.11g operation of this product in the U.S.A is firmware-limited to channels 1 through 11. 

IMPORTANT NOTE:  
FCC Radiation Exposure Statement:  
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. This 

equipment should be installed and operated with minimum distance 20cm between the radiator & your body.  

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.  

The availability of some specific channels and/or operational frequency bands are country dependent and are 

firmware programmed at the factory to match the intended destination. The firmware setting is not accessible by 

the end user. 
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Note to CATV System Installer - This reminder is provided to call the CATV systems installer's attention to 

Section 820-93 of the National Electric Code which provide guideline for proper grounding and, in particular, 

specify that the Coaxial cable shield shall be connected to the grounding system of the building, as close to the 

point of cable entry as practical. 

 

FCC Part 68 Statement 

This equipment complies with Part 68 of the FCC Rules. A label is attached to the equipment that contains, 

among other information, its FCC registration number and ringer equivalence number. If requested, this 

information must be provided to the telephone company. 

This equipment uses the following USOC Jack: RJ-11. 

An FCC-compliant telephone cord and modular plug is provided with this equipment. This equipment is designed 

to be connected to the telephone network or premises wiring using a compatible modular jack, which is FCC Part 

68 compliant. Connection to the telephone network should be made by using the standard modular telephone 

jack. 

The REN is useful to determine the quantity of devices that may be connected to the telephone line and still have 

all of those devices ring when your telephone number is called. In most, but not all areas, the sum of RENs 

should not exceed 5. To be certain of the number of devices that may be connected to the line, as determined by 

the total RENs, contact the telephone company to determine the maximum REN for the calling area. 

If this equipment causes harm to the telephone network, the telephone company may discontinue your service 

temporarily. If advance notice is not practical, the telephone company will notify the customer as soon as 

possible. Also, you will be advised of your right to file a complaint with the FCC if you believe it is necessary. 

The telephone company may make changes in its facilities, equipment, operations, or procedures that could 

affect the operation of the equipment. If this happens, the telephone company will provide advance notice in 

order for you to make the necessary modifications in order to maintain uninterrupted service. 

In the event this equipment should fail to operate properly, disconnect the unit from the telephone line. Try using 

another FCC approved device in the same telephone jack. If the trouble persists, call the telephone company 

repair service bureau. If the trouble does not persist and appears to be with this unit, disconnect the unit from the 

telephone line and discontinue use of the unit until it is repaired. Please note that the telephone company may 

ask that you disconnect the equipment from the telephone network until the problem has been corrected or until 

you are sure that the equipment is not malfunctioning. 

The user must use the accessories and cables supplied by the manufacturer to get optimum performance from 

the product.  

No repairs may be done by the customer. If trouble is experienced with this equipment, please contact your 

authorized support provider for repair and warranty information. If the trouble is causing harm to the telephone 

network, the telephone company may request you remove the equipment from the network until the problem is 

resolved. This equipment cannot be used on telephone company provided coin service. Connection to Party Line 

Service is subject to state tariffs.
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